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General 1

This chapter contains the following sections:

e Glossary and Acronyms

This document describes the usage of the MX-ONE Service Node (SN) packed as a Virtual Appliance for
VMware vSphere ESXi 8.0 hypervisor (minimum), Hyper-V, Nutanix, and Proxmox VE.

If an existing MiVoice MX-ONE system has used Turnkey Solution installation (with hardware), and shall be
changed into a Virtual Appliance installation, that has to be done as a new installation with Virtual Appliance.

1.1 Glossary and Acronyms

For a complete list of abbreviations and glossary, see the description for ACRONYMS, ABBREVIATIONS
AND GLOSSARY.
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Prerequisites 2

* The vSphere Client installed on a workstation.

*  VMware ESXi 8.0 host (minimum version 5.5), a vCenter solution, Hyper-V, Nutanix, and Proxmox VE.
Recommended version for VMware ESXi is 8.0 or later.

+  The MX-ONE Service Node Virtual Appliance file.
* Good knowledge of VMware vSphere, Hyper-V, Nutanix, and Proxmox VE.
* Good knowledge of SLES12 and MX-ONE installation.

* Read the MiVoice MX-ONE SYSTEM PLANNING description, and the description VIRTUALIZATION FOR
MIVOICE MX-ONE 7.0 or later.

e Note:

For database (Cassandra) server VMs, co-located or stand-alone, SSD disks are required.
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Execution

The procedure involves the following 3 major tasks:

1. Importing the Virtual Appliance to any one of the following:

a single ESXi host
a vCenter cluster
Hyper-V

Nutanix

Proxmox VE

2. Post-configuring a newly imported MX-ONE virtual machine
3. Installing and Configuring MX-ONE
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Importing the Virtual Appliance 4

This chapter contains the following sections:

* Importing on a Single ESXi Host (From ESXi 6.5)
* Importing on a Single ESXi host (From ESXI 6.0 Or Earlier)
* Importing into a vCenter Cluster

This section describes how to install the MX-ONE Service Node Virtual Appliance on a virtual machine.

4.1 Importing on a Single ESXi Host (From ESXi 6.5)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a single VMware
ESXi host through the VMware host client. This scenario applies to the free version of ESXi.

1. Log in directly to the ESXi host through the VMware Host Client (via Web browser enter the IP address/
FQDN of the ESXi host).

2. Click Host and from the main menu, select Create/Register VM. A wizard opens that will assist in the
deployment process. in the first step, select the Creation Type and select Deploy a virtual machine from
an OVF or OVA file.

3. On the next page, specify a name for the virtual machine and select the OVF and VMDK files or the
OVA for the VM you want to deploy.

4. Select a data store for the virtual machine. It could be either local or centralized (SAN).

5. Map the networks used in this OVF to networks in your inventory, select disk format for the virtual
disks. Thick provisioning allocates all space at once, thin allocates on demand. Thick gives a slight
performance gain and eliminates the risk of over-shooting actual storage space.

6. You will get a summary page to review your settings selection before you exit the wizard and proceed to
start the deployment.

7. Click Finish to start the deployment task.

4.2 Importing on a Single ESXi host (From ESXI 6.0 Or
Earlier)

This section describes how to install the MX-ONE Service Node Virtual Appliance on a
single VMware ESXi host through the vSphere client. This scenario applies to the free

version of ESXi.

1. Log in directly to the ESXi host through the vSphere client.
2. From the File menu, select Deploy OVF Template....

3. A wizard opens that will assist you with deployment process. In the first, select the Virtual Appliance file.
Next page shows some information about the Virtual Appliance.
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Importing the Virtual Appliance

4. Specify a name and location for the deployed template.

5. Select a data store for the virtual machine. It could be either local or centralized (SAN).
6. Select thick lazy zero provisioning as the disk format for the virtual disks.

7. Map the networks used in this OVF to networks in your inventory.

8. All done - click Finish to start the deployment task.

4.3 Importing into a vCenter Cluster

This section describes the import process of a MX-ONE Service Node Virtual Appliance in a VMware
vCenter cluster environment.

Such an environment contains multiple hosts, centralized storage, and distributed network and supports
the vCenter features such as vMotion, High Availability (HA), and Fault Tolerance (FT).

1. From the vSphere client or vSphere Web client, log on to the vCenter server.

2. If you are importing on a vSphere client, select from the File menu and select Deploy OVF Template....
A wizard opens that guides you through the deployment process.Select the Virtual Appliance file to
import.

3. A page opens showing information about the Virtual Appliance.

a. Select the Virtual Appliance file to import. A page opens showing information about the Virtual
Appliance.

b. Enter a name for the virtual machine, and also, select the datacenter where it should be used.

c. Select the host or cluster that should handle the new virtual machine. A review page with data about
the Virtual Appliance is displayed.

4. If you are importing on a vSphere Web client, right- click on the vCenter server and select Deploy OVF
Template.... A wizard opens that guides you through the deployment process.

a. Select the Virtual Appliance file to import.
b. Enter a name for the virtual machine, and also, select the datacenter where it must be used.
c. Select the host or cluster or resource pool or vapp where to run the new virtual machine. A review
page with data about the Virtual Appliance is displayed.
5. Select datastore for the virtual machine. Choose a centralized storage (SAN) if HA/FT will be used.

6. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

7. Select the disk format for the virtual disks. If FT will be used, or thick provisioning must be selected. For
other cases, select any format (you can keep the default selected).

8. Select the virtual network the virtual machine must connect to. In a clustered environment, this is
normally a Distributed Switch. Be sure that switch is connected to the production/telephony network

9. With this all, necessary information is now collected. Click Finish to start the deployment task.

After you finish importing a Virtual Appliance by using a single ESXi host or a vCenter cluster, you will
have a MX-ONE Service Node in turnkey state. At this moment, the server is not yet configured and is
generic (it has not yet been assigned any specific function). Starting up the virtual machine triggers the
turnkey installation process, which is identical to the one used for physical MX-ONE servers. If more than
one MX-ONE Service Node is needed, just run the process above multiple times using the same Virtual
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Appliance file. Give each virtual machine an unique name and distribute them over the hosts in the cluster
(how depends on the cluster setup, the amount of servers inside the cluster and the load on the hosts)



Post-Configuration of a Newly 5
Imported MX-ONE VM

Before using a newly imported MX-ONE virtual server, some settings must be considered and maybe changed.
These are mainly related to processor and memory allocation

* Hardware - Memory

The amount of memory the virtual machine is equipped with. The value must be changed according to the
system size and the MX-ONE application that the server will run, e.g. Service Node, Service Node Manager,
Database (Cassandra), Provisioning Manager and Media Server. For configuration and planning of virtualization,
see the description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

« Hardware - CPU

By default, two CPUs are allocated to the virtual machine. If you plan to use Fault Tolerance together with the
MX-ONE Service Node, this must be changed up to 8 vCPUs. Also, numbers of CPUs needed in a server
depends on desired performance and system size. For configuration and planning of virtualization, see the
description VIRTUALIZATION FOR MIVOICE MX-ONE 7.0 or later.

* Options - Paravirtualization

This must be disabled on Fault Tolerance-enabled virtual machines as it is not supported. On all other
configurations, keep this enabled.

¢ Resources - CPU

This setting affects the resource allocation in the cluster/host. This must be configured to match required
performance of the MX-ONE and the capacity of the cluster/host and how many virtual machines are running in
parallel.

* Resources - Memory

As for the CPU-resources, this setting depends on the capacity needed, the cluster/host configuration and how
many other virtual machines are running in parallel.

* Disks

For database (Cassandra) server VMs co-located or stand-alone, SSD disks are required.
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e Note:

Be sure that the network configuration of the virtual machines is properly set up in the cluster. By default,
the standard "VM Network" is used. In a cluster environment where distributed switches are used (a
requirement if HA/FT is used), this must certainly be changed.



Installing MX-ONE on Hyper-V 6

The Microsoft hardware Virtualization product, Hyper-V lets you create and run a software version of a computer,
called a virtual machine. Each virtual machine acts like a complete computer, running an operating system and
programs. The following are the requirements of the virtual machine.

* It can be installed on Windows Server (2022 and 2019)

» It requires only a Windows license and no specific license is required.

*  Windows Server can be installed on a Dell or an HP server.lt is similar to VMware in its functioning.
* It uses .vhd and. vhdx format image for installation.

To install MX-ONE on a Hyper-V setup:

Once the Windows Server get successfully installed,
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1. Enable Hyper-V using PowerShell.

a. Open a PowerShell console as Administrator.

Installing MX-ONE on Hyper-V

b. Run Enabl e- W ndowsOpt i onal Feature -Online -FeatureNanme M crosoft-Hyper-V -All

command to install Hyper-V.

EN Administrator: Windows PowerShell

. All rights reserw

Administrator= Enable-WindowsOptionalFeature

Tt-Hyper-Vv

c. Or you can open the service manager - Add role and features and install Hyper-V.

Server Manager > Dashboard

Dashboard WELCOME TO SERVER MANAGER

I Local Server

Al Servers

° Configure this local server

W8 File and Storage Services b
B Hyper-v QUICK START

T Add Roles and Features Wizard

Select server roles

Roles

o
[ Active Directory Domain Services
[] Active Directory Federation Services

[[] Device Health Attestation
] DHCP Server

[J DNS Server

[ Fax Server

[ Heost Guardian Service

| Hyper-V (installed)

[[] MultiPoint Services

[0 Network Policy and Access Services
[ Print and Document Services

[] Remote Access

[] Remote Desktop Services

[] Volume Activation Services

[ Web Server (1IS)

[[] Windows Deployment Services

Select one or more roles to install on the selected server.

[ Active Directory Lightweight Directory Services
] Active Directory Rights Management Services

W] File and Storage Services (1 of 12 installed)

- o

DESTINATION SERVER
WIN-3SMLI7LAMDG

Description

Active Directory Certificate Services
(AD CS) is used to create
certification authorities and related
role services that allow you to issue
and manage certificates used in a
variety of applications

i All Servers 1

Manzgesbility
Events

I sevices
Performanca

BPA results

R Server Manager

Server Manager * Dashboard

i All Servers
R File and Storage Services b
B Hyper-v

Local Server
M 0 Configure this local server

WHAT'S NEW

LEARN MORE

ROLES AND SERVER GROUPS
Roles:2 | S 1

== File and Storage

L] 1 Hyper-V 1 ocal Server
¥ Services & e

® Manageability ® Manageability ® Manageability

28/1531-ANF 901 14 Uen H

® Manageability

Service Node Virtual Appliance - Installation Instructions




Installing MX-ONE on Hyper-V

8 Hyper-V Manager
File Action

iew Help

- x
e 2m HE
(B Fyper ¥ Vamager =
. Virtust Machines
[l = VIN-SSMUTLAMDG <
Name site CPUUsage  AssignedMemory  Uptime Status Confgurat . "
o v machiss wer e o this s

. Import Virual Machine.
] Hyper Setings.

2. Before you install, create a Virtual Switch Manager for Hyper-V to give network access to the virtual
machines.

3. Select Virtual Switch Manager from the right pane

B8 by Mmger

- x
L IE]
[ Fyper iamsger Ations
i WIN-3SMLUTLAMDG Vietual Machines SREE—— B
Name sate GUUsge  Assgned Memory  Uptime st

Novetul machines were found on this snvr,

4. Select the type of switch, in this case, an External Switch.

P

Fie Adion View Help
oo am B
55 Fyper ¥ M

e
I T
E{E s > =
T it
B3 Virtual Switch Manager for WIN-35MLITLAMDG x
e
SEesrE v
s
‘
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5. Enter a Name for your switch and click Apply.

B0 Hyper-V Manager
Fle Acion View Help
LX IR o] 7]

Installing MX-ONE on

state

CPUUssge  AssignedMemory  Uptime. Status Configurst

Novitusl machins were found on i sever.

58 Vit Sitch Managerfor WIN-35MLITLAMDG - X
% Virtual Switches =
3% New vitua netvork sich
ox Hame:
roadion NeiXvene GoabtEder . | ewvwnalowin ]
5 % Hew Virtual Switch
totes:
2 Global etworlSettings
T maC address e
o
Conecton toe

Vihat do you want to connect s viualsitch to?
© Extemal netnork:
Broadcom NetXtreme Ggabt Ethermet 5
7 Ao management aperating system toshere this netvrk sdapter
] Enabie sngle-ro0t 10 vituazation (S8:101)
O tntermalnetvork
O Private network
W
L] Enaie vl Lt censficaton for management aperatng system

FE Hyper-V Manager
[l WIN3SMUTLAMDG, Virtusl Machines
Namme
Checkpaints
Detais

6. Your configured Network Switch is listed in the Network Connections.

&) Network Connections

‘Actions

WIN-SSMUTLAMDG B
New »
Import Vitusl Machine...

Hiyper-V Setings

Virtual Switch Manager.

Virtual SAN Manager.

i Disk.

2]

inspect Dick.

Stop Senice:

Remove Server

e x

Refresh
View »
Help

swich,

[ R

4+ & > Control Panel > Network and Internet > Network Connections

Organize =

=~ NiCT
%ﬁ Enabled

@ Broadcom Netitreme Gigabit Eth...

Disable this network device

3 @7 Broadcom Netitreme Gigabit Eth...

Diagnose this connection  Rename this connection  View status of this connection
— vEthernet (Broadcom NetXtreme
b Gigabit Ethemet - Virtual Switch)
@ Network 2

=~ N2
Network cable unplugged

7. Create a virtual instance.
8. Select New > Virtual Machine.

8 Hyper-V Manzger

- m]

v o

Search Network Connections 0

Change settings of this connection 52 + [H @

- 8 x
Fle Acion View Hep
e% 2w HE
Hyper- Manager Actions
[Bmtes |t et
ew) 2] [ vatal Machine PUUssge  AssignedMemory  Uptime Status Configurat,
Import Vitusl Machine. HardDisk.. New »
o vt machines wer found o thisserver B oot Vetuet Miachine
Hyper-V Settings. Floppy Disk. 7 Import Virtual Machi
Virtual Switch Manager. 7 Hyper-V Settings.
Virtual SAN Manager, 2 Vintuol Switch Manager...
eatDik 4 Vitual AN Mianager.
Ispect Disk.. & EdtDis
£ tnspectDisk.
Stop Service - Insp
Remove Server ®) Stop Service
Refrsh X Remove Server
Refesh
View > )
View »
. H‘ )
B8 Hyper Y Manages N
Fle Acion View Help
e 2@ Em
Virtual Machines. ons
B Wi-MMAMDG | 5 WIN-3SMLITLAMDG -
Neme sute CPUUsge  Assigned Memory  Uptime sotus Confgurt S R
Novetua machines wers foed on i v R ——
] Hyper-V Settings.
42 Virtual Switch Menager.
4L Vitual AN Manager.
3 New Vituo Machine Wizard x & EdrDik.
2 InspectDisk.
= Specify N: \d Locatior ®) Stop Service
pecify Name and Location
X Remove Server
© Refeh
‘Chaose a e and ocationfr thi it machine. View >
Help
Asson vemory e T
Jou dont st s
fios,
o
Sunmary Locaton: [CoProgeanDataerosotWindows yper¥\
A
<prevous | (oo ] [ roen s
| Checkpolats -
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Installing MX-ONE on Hyper-V

10. Assign memory as per the requirement and click Next.

18 Hyper-V Manages
Fie Adion View Help
e 2@ EE

e = Vietal Machines Acts
BeEmEsA AT = VINISMUTLAMDG N
Neme sute CPUUssge  AsignedMemary  Uptime Satus Confgurt S R
Mo viua machines wer fond o s sever % Import Vitual Machine.
(] Hyper-V Settings.
£2 Virual Switch Manager.
4 Vitua SAN Manager,
3 New Vil Machine Wizard x
S Assign Memor
on temory X Removesener
© Refren
sefre Youegm e view »
e o
Hep
Surtomenary: [ e 18
(0] s Dy emory o tis el machne
O e e
nstalaton Optons
Summary
e | [
Checkpoints

11. Select the Network Switch which you have configured initially and click Next.

Ia -
e Acien View Help
es 2@ @

B hpery Mansger

s
: Vit Macines
s an0s = Eaa -
Name Se g AsondMemoy  Uptme  Sius Conigut, 2 :
[P ——— P
B thpervsetings.
ZE Viual Switch Manager.
. Vit SAN e
30 New Virtual Machine Wizard. X
= Configure Networking
seoevouseon a ,
Soncty G
e
P o [l
Checooins 5
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Installing MX-ONE on Hyper-V

12. Select the image (VHD) by selecting the option, Use an existing virtual Hard disk and select the location
where your VHD image is stored (In case of MX-ONE Unzip the Hyper-V Image and select the Virtual Hard
Disk ).

B Hype
File Action View Help

= 2ol HE

BB HyperV Manager - -
B WIN-35MLITLAMDG Virtual Machines
Name State CPUUsage  Assigned Memary  Uptime Status Configurati..
No vitual machines were found on this server.
30 New Virtual Machine Wizard x
= Connect Virtual Hard Disk
Before You Begin A storage 5o that operating systen. the
. storage now or confgure tlater by modifying the vitual machine & properties.
Specify Generation Q Create a virtual hard disk-
A h— Use this option to create 2 VHDX dynamically expanding virtual hard disk.
Configure Networking MX-ONE LIM L vhix
Comect el o Do (C:\Jsers|publiciDocuments\Hyper-V1Virtual Hard Disks
Summar,
i 127 GB (Maximum: 64T)
@® Use an existing virtual hard disk
Use this option to attach an existing vitual hard dis, ether VHD or VHDX format,
B | erowse
O Attach a vitual herd disk ater
Use this option to skip attach an existing
T || o=
[rar—— 2
B Hyper-y Manage
File Action View Help
+ = m Bm
B Hyper-V Manager - -
B WIN-35MLI7LAMDG Virtual Machines
Name State CPUUsage  AssignedMemory  Uptime Status Configurat
No vitusl machines were found on this server.
3 Open X
« ~ 4[> ThisPC » Desktop > HyperV-Image-MX-ONE 7.1.5p0hf0.rc10 » Virtual Hard Disks v O | Search Virtual Hard Disks L
Organize v New folder v m @
Name - Date modified Trpe Size
# Quick access
 peskon s MX-ONE_7.1:5p0T0.1c10 1/28/2019 10:46 AM _ Hard Disk Image F..
& Downlosds
5] Documents
=] Pictures.
Virtual hard disks:
@ Microsoft Managem¢
2 This pC
‘i Local Disk (C)
& Network
File name: | MX-ONE 7.1.5p0.hfD.rc10 v‘ Virtual hard disk files
Checknoints
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Installing MX-ONE on Hyper-V

8 Hyper-V Manager
File Action View Help
o= o B

[ Hyper-V Manager - .
[ WIN-35MLITLAMDG Virtual Machines

Name State CPUUsage  Assigned} :mory  Uptime Status Configurati,

No vitual machines were found on this server.

[ New Virtual Machine Wizard
= ‘Completing the New Virtual Machine Wizard

Before You Begin

the N 3 the

P following virtual machine.

Specy Generation Descrpton:
Asign Memory Neme:  MX-ONELIML
Configure Networking Generation: Generation 1

Memory: 8000 MB
Network:  Broadcom NetXireme Gigabit Ethernet - Virtual Switch
HardDisk:  C:\Users\Administrator \Desktop iyper/-Image-X-ONE_7. 1.5p0.hfi.rc10Wirtual Hard

Conect Virtual Hard Disk.

<

>
To reate the virtual machine and diase the wizard, cick Firish,
<prevous | |l Cancel
B Hyper-V Manager
File Action View Help
e znm@ B
R Hyper-V Manager - -
B WIN-09LOSKIZUT Virtual Machines
Name State CPUUsage  Assigned Memory  Uptime Status Configurati
B mxoNELMT Runring o 2000MB 000106 20
£ Settings for MX-ONE-LIMT on WIN-QILOSK123)T - x
MX-ONE-LIM1 v (3]
A Hardware ~ [ B AdaHardnare
= br0s You can use this setting to add devices to your virtusl machine
Boot from & Select the devices you want to add and cick the Add button,
@ seariy SO Cantraler
Key Starage Drive disabled Network Adapter
W Memory Remetex 30 tidea Adpter
s000 e Legacy Netuork Adzpter
[ Processor Fibre Channel Adspter
1Virtual processor
Add
Checkpoints ¢
&l sCst Controler
§ Netnork Adapter
New Vrtual Switch
@ comt
None
& comz
None
[l oisetie ive
None
2 Management
MX-ONEAIM1
) Tntegration services
Some services offerad
) Chedkpoints
Producton
%@ smart Paging Fiie Location
c: v
}"’“’""“"" Cancel Aoy
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Installing MX-ONE on Hyper-V

14. Start the machine and install MX-ONE setup as shown in the following figures.

i
File Action View Help

B MX-ONE-LIM1 on WIN-35MLITLAMDG - Virtual Machine Connection - o x
L2 =l B = -

5 Hyper-V Manager
[ WIN-35MLI7LAMDG o DO /i

File Acion Media Clipboard View Help

Actions

WIN-35MLITLAMDG
NU GRUB Configurat 2
GNU GRUB uversion 2.02

80 e

% Import Virtual M
HyperV Setings
2 VitualSwitch Me
Virtual SAN Manc
it ik
Inspect Disk.
Stop Senvice

Remove Server

Rt
Vew
e
Use the 1 and 1 keys to select which entry is highlighted
Press enter to boot the sclected 03, “¢° fo edit the commands \
booting or ‘c’ for & command-line
ghted entry uill be excouted autamatically in 3s

IX-ONE-LIM1

8 Connect.

Tum Of,

Status: Running =0 Shut Down

17}
M
8
B9 Settings.
]
(]

Save

=

File Action View Help

€= znm BF

B Hyper-V Manager )

Bl WIN-QOLOSK1zz/T| File Action Media Clipboard View Help
;%) D@0 i |fy

MX-ONE Telephony Systen Setup, Uersion:?.1.8.0.1

E MIXONE on WIN-Q9LOSK1231T - Virtusl Machine Connection - o x

MX-ONE_Initial Setup
Uelcone to MX-ONE Telephony System Setup

You have to configure your server before starting
the Telephony Systen.
Do you want to configure your server nou?

<o >

s
File Action View Help
L IRl 7 iy
F Hyper-V Manager

B2 WIN-QaLOsK123yT| File Action Media Clipboard View Help

B ONoNo NRTITSN-

B MXONE on WIN-QSLOSK123JT - Virtusl Machine Connection - o x

NE Initial Setup
Successful restart of netuork
service

Missing servers will not be included if you choose to continue
They can be added later

uait for expected server(s) to appear
New server data file(s) received from:
mxone-1in1.mitel.con

Press ¢ to continue

Status: Running =0
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File Action View

BB Hyper

V Manager

Help

E MXONE on WIN-QILOSKI23T - Virtual Machine Connection

B WIN-QaLOSKizaT| Fle Acion Medis Clpboard View Help

©®@®0 | nn»

createTabl 1/ete/mxon

nstall,7.1.0.0.1/target install_scripts ceNode “ins
Inserting Alarn Configuration into database’

serting default domain data into database

k

Executing “start” in all server

istribute s
K

jait for LIM(s) to star
fax wait time: 11 minut
tart0fSysten occured
Initial Start Of System Successful
The MXONE systen is started ok
Executing data_backup
ackup ok

onf ig_nirror ok

P T T e e e T T e e e e
"

# OBSERVE!! To get correct group membership logout and in again. #
" 1

T —————
Installing addon sof tuare

Installing MX-ONE Service Node Manager - please wait

Starting silent installation of mxo

_snm rpn
‘ollou progress by opening another shell and type:
ail —f -n B svarlog/mxone uebserver appl i

eated synlink fron setc/systend systen/nulti-user. target uants/mxone_jboss.service to usr

tallation of MX-ONE Service Node Mamager is finis}
lebserver uill now be re-started. This may take a uhil
jboss/standalone log/server . log
e /var/log/meo r/application_log. log fe

e_cql.

tConf igDataInDB

1ibssystend systen nxone_jbos

Actions
WIN-QOLOSKIZT
New

% Import Virtual Machine.
Hyper-V Setings.
VitualSwitch Manager.
Vitual SAN Mznager.
EditDisk.

£ Inspect Disk
®) Stop Senvice
X Remove Server
© Refresh

View
B Hep
MXONE
8 Comnect
B2 Settings.
) Tum O,
© shutDown.
O save
I Pause
1 Reset
By Checkpoint
B Move
[ Epor
1 Rename.
& Enable Replication

@ Hep




Installing MX-ONE KVM, SuSE Linux 7

To install MX-ONE on the Kernel-based Virtual Machine (KVM) on the SuSE Linux platform, follow these steps:

. Download the MX-ONE ISO image (Recovery image) from the MX-ONE repository.

. Make a bootable USB and load it with the Recovery image to install OS with KVM capability.
. Run the USB and select option 3 (KVM install).

. Install the KVM image and system is restored with SUSE Linux installed.

HOON =

5. Enter the root login credentials.

6. Using the Yast utility, enter IP address, Gateway, DNS and subnet Mask to the system. For more information
see, https://www.suse.com/documentation/sled11/book_sle_admin/index.html?page=/documentation/sled11/
book_sle_admin/data/sec_basicnet_yast.html.

B

199999999979999939999999939933999999939993993999399999I999IIITITITE

7. Using the configured IP address login to the terminal using putty.
8. For the installation of KVM over SUSE download the. gcow2 and .xml files from the package repository.
9. Check if | i bvi rt d is running or not, else startit: sudo systenct| status libvirtd

libvirtd.service - Virtualization daenon Loaded: | oaded (/usr/lib/
systenmd/ system | i bvirtd. servi ce; enabl ed; vendor preset: enabl ed) Active:
active (running) since Mon 2019-04-08 14:38:40 CEST; 22h ago Docs:
man: | i bvirtd(8) https://libvirt.org Main PID: 21036 (libvirtd)
Tasks: 18 (limt: 32768) CG oup: /systemslicel/libvirtd.service
??21036 /usr/sbin/libvirtd -listen
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Installing MX-ONE KVM, SuSE Linux

10. Create a virtual machine, entervirt-cl one --original -xm Virtual _I mage- MX-
ONE_7.0.sp0. hf2.rc5.xm --name <your system nanme> --file /local/inmages/<your
syst em name>. gcow?2

For example,virt-cl one --original-xm Virtual | nmage-MX-ONE 7.1.sp0.hf0.rc26.xm --
nane MX-ONE --file /1l ocal / MX-ONE. qcow2

e Note:

Keep the gcow2 and xml under the local folder. Edit (vi) the xml file and change the default path from /
kvm/images to /local where you have saved the image file.

11. When the kvm image installation is complete, create a network bridge and map it to the et h0 that you are
using so that KVM can access it.

12. To add a new network bridge device on VM Host Server with br ct | , follow these steps:

a. Log in as root on the VM Host Server where you want to create a new network bridge.

b. Choose a name for the new bridge-VIRBR_TEST in our example- and runr oot # brctl addbr
VI RBR_TEST.

c. Check if the bridge was created on VM Host Server r oot # brctl show

bri dge nane bridge id STP enabl ed interfaces br0
8000. e06995ec09e8 no ethO virbroO
8000. 525400b37ec9 yes Virbr0O-nic virbr_test

8000. 000000000000 no

o Note:

Vi rbr _test is listed, but not associated with any physical network interface

d. Add a network interface to the bridge usingroot # brctl addif VI RBR TEST et hl command.

e Note:

Network interface must not be already in use. This is because you can only enslave a network
interface that is not yet used by other network bridge.

e. Optionally, enable STP usingroot # brctl stp VI RBR_TEST on command.

For more information, see https://www.suse.com/documentation/sles-12/book_virt/data/
libvirt_networks_bridged.html.

brctl showbri dge nane bridge id STP enabl ed
i nterfacesbrO 8000. 28b9d9e09f 41 no et ho
vnet 0

13. To start your virtual machine, install Mobaxterm (GUI or X server support). See https://
mobaxterm.mobatek.net/download-home-edition.html
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14. Run KVM machine and run vi r t - manager on the command line.

B root®linux-2drw:~
Teminal  Sesions View  Xsever Tools Games Setings  Mocros  Help
E % % % A ® BE Y B2 & & @ X ©

Session  Seves  Took  Gemes Sessions  Vew  Spit  MubEvec Tumeing Paddages Seitngs  Heb Xeerver

@i 20w

~ # virt-manager I

Reconnect SSH-browser

& Toss
&

Xauthoity

A Macms

This gives you the virtual manager access through which you, start, stop, or change the MX-ONE deployed
KVM and install it.

8 Virtual Machine Managerlinus-2dw
Fle Edt View Help

B = o Al -

~ qeMum

e

¥ MX-ONE on QEMU/KVMG@linux-2dnv - ¢
file Virtual Machine View Send Key

- U - &

To get correct group membership logout and in again.
e e e
Installing addon sof tuare
please vait
installation of mxom
opening anoth e
0 v pplication_log. log
target .uants/mxone_jl to susr/libssystend system/mxone_jbo:

Ilation of MX-ONE Service Node Manager is f
ruer will nou b arted. This may take a u

me~log/server . log
log/mxane.

var uebserver/application_log.log for details

dropped:0 overr

08
Hb) TX bytes

Linux-6ny

15. Executables are stored in/ usr/ | i bexe.



Installing MX-ONE KVM on Redhat
Linux

To install Kernel-based Virtual Machine (KVM) on Redhat Linux, follow these steps:

1. Install the Redhat-7.6 OS through a bootable pen-drive or any other external media.
2. Create a bridge interface; for example, i f cf g- br 0.

0 Note:

For configuration details, see Network Bridge.

3. Copy the MX- ONE . gcow? image to the host machine to continue installation. See Creating a VM by
Importing an MX-ONE gcow?2 Image on page 21 for installation instructions.

Creating a VM by Importing an MX-ONE qcow2 Image

To create a virtual machine (VM) by importing an MX- ONE qcow? image, follow these steps:

1. Log in to your machine as root user.
2. Navigate to the directory of the installation files previously downloaded.

e Note:

Create a backup copy of the image file.

3. Move the image file to the directory where you want to place the virtual machine.

4. i

Start the Virtual Manager and click Create a new virtual machine =
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Installing MX-ONE KVM on Redhat Linux

5. Select Import existing disk image and click Forward. See Create a new virtual machine screen for details.

Figure 1: Create a new virtual machine screen

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system
Local install media (ISO image or COROM)
Network Install (HTTP, FTP, or NFS)
Network Boot (PXE)
e) Import existing disk image

w Architecture options

Architecture: | x86_64 »

Cancel Back Forward

6. Click Browse and navigate to the path of the image file.

7. Select the image file and select the operating system type and version from the following fields and click
Forward. See Selecting the OS and version for details.

* OS type
¢ Version

m Create a new virtual machine

Provide the existing storage path:

| flocalfimages/new_machine.qcow2 Browse...

Choose an operating system type and version

0S type: | Linux -
\ersion: | SUSE Linux Enterprise ¢ | «
Cancel : ‘ Back | Forward

Figure 2: Selecting the OS and version
8. Complete the following fields and click Forward (see Memory and CPU settings for details):

*  Memory (RAM)
« CPUs

28/1531-ANF 901 14 Uen H
Service Node Virtual Appliance - Installation Instructions




Installing MX-ONE KVM on Redhat Linux

e Note:

For the memory and CPU settings, specify values that match your system. For the purposes of this
procedure, the values 6 GB RAM (6144 MB) and 2 CPUs are specified.

Figure 3: Memory and CPU settings

m Create a new virtual machine

Choose Memory and CPU settings

Memory (RAM): | 144 = |l ‘

Up to 96255 MIB available on the host
CPUSs: | 7| & |

Up to 12 available

Cancel Back Forward
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Installing MX-ONE KVM on Redhat Linux

9. Click Finish. See Creating a VM for details.

The details of the VM to be created are displayed.

Figure 4: Creating a VM

Ready to begin the installation

Name: | new_maching|

0S: SUSE Linux Enterprise Server 12 SP4
Install: Import existing OS image
Memory: 6144 MiB
CPUs: 2
Storage: /local/images/new_machine.qcow2

Iz Customize configuration before install

» Network selection

Cancel ‘ Back Finish

10. Click Begin Installation. The virtual machine is created. See Begin Installation for details.

Figure 5: Begin Installation

</ Begin Installation @ Cancel installation

{3 CPUs MNarme: new_machine ‘

&5 Memory uuID: 5b8a0ad2-ag3b-41c8-baBe-5e56bf8c2533

gi} Boot Options Status: B shutoff (Shut Down)

_ Virtlo Disk 1

=V 2 Title: ‘

B NIC :80:02:3d -
Description:

!I Tablet
! Display Spice

HF Sound ich6

G'G Console Hypervisor Details

= Channel gemu-ga Hypervisor: KVM

£~ Channel spice Architecture: x86_64

B video oxL Emulator: fusr/bin/gemu-kvm

= Firmware:

MF Controller USB 0 ‘ BIOS =
) USB Redirector 1 i ] 7

@ i Chipset ‘ e ‘

@ USB Redirector 2
gi} RNG jdevjurandom
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11. Use the Mobaxterm (GUI or X server support). to open a virtual manager session. See Virtual Machine
Manager for details.

Figure 6: Virtual Machine Manager

[}
b

¥ Virtual Machine Manager@localhost.localdomain = O X

File Edit View Help

II-I B Open n -
Name v CPU usage
v QEMU/KVM

MXONE-KVM-REDHAT
Running |



Installing MX-ONE on Nutanix AHV

This section describes the procedure to install MX-ONE on Nutanix AHV platform.

Prerequisites

» Ensure that you have downloaded the MX-ONE OVA file from the distribution server or you have the valid
URL to the MX-ONE OVA file.

* You have a valid user name and password for the Nutanix AHV web console.

Procedure

To install MX-ONE on Nutanix AHV:

1. Log in to the Nutanix AHV web console. For more information, see https://portal.nutanix.com/page/
documents/details?targetld=Web-Console-Guide-Prism-v6_7:wc-login-wc-t.html.

2. Navigate to the Dashboard and click on OVAs.
. Click on Upload OVA.
4. Upload the OVA file by using either of the following options.

w

» OVA File. Select this method if you have already downloaded the OVA file in your location.
* URL. Select this method if you have not downloaded the OVA file in your local system.
5. Configure the other default parameters and click on Upload.

e Note:

The OVA file upload will take around 30 minutes to 1 hour.

6. After the upload is complete, navigate to the Dashboard > OVAs.

The newly added OVA file entry is displayed.
7. Select the new entry.
8. From Actions drop down menu, select Deploy as VM.
9. Configure the following sections as per the site environment.

» Configuration
* Resources
+ Management
* Review
10. Click Create VM.
11. Navigate to the Dashboard > VMs.
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12. Click on the VM that is created in Step 10. The status of the VM will be in Red indicating that it is not up and
running yet.

A new VM Summary page is displayed.

13. Click Power On at the top right side of the page. The status of the VM will be in green indicating that it is now
up and running.

14. On VM Summary page, click on Console and click on launch on the new window icon (next to the camera
icon) to start the MX-ONE installation as described in the Installing and Configuring MX-ONE on page 32.



Installing MX-ONE on Proxmox VE 10

e Note:

This section focus only on the mandatory parameter configuration. Users can modify the default parameter
values based on the site requirements.

Prerequisite

» Ensure that you have downloaded and installed the Proxmox VE on your system. For more information, refer
to the https://www.proxmox.com/en/proxmox-virtual-environment/get-started.

» Ensure that you have downloaded the ISO image file. For example, Recovery Image-MX-
ONE_x.x.spx.hfx.rcx.iso.

» Ensure that you have downloaded the either of the following checksum file.

* Recovery_Image-MX-ONE_x.x.spx.hfx.rcx.iso.sha256

(Or)
*  Recovery_Image-MX-ONE_x.x.spx.hfx.rcx.iso.md5

Uploading ISO Image on Proxmox VE

To upload ISO image on Proxmox VE:

1. Log in to the Proxmox VE.
2. On Proxmox VE homepage, navigate to Datacenter.
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3. Select the appropriate project and click on ISO Images as depicted in the following figure.

X PRO MO X virual Environment 8.2.2 Search

Server View

o Storage local’ on node

& Summary
2

100 (PROXMOX-LIM1) Backups

L3 101 (PROXMOX-LIM2) ® IS0 Images 14

{

{

L3 102 (PROXMOX-LIM3) [% CT Templates
L) 103 (PROXMOX-STB) f

b 104 (PROXMOX-MS) a' Permissions
=2z localnetwork (mxa)

= Jlocal (o) 3

= || local-lvm (mxo)

L —

Figure 7: Uploading ISO Image
4. Click on Upload. The Upload pop-up window appears.

a. Click on Select File, and select the Recovery Image-MX-ONE_x.x.spx.hfx.rcx.iso file that you have
already downloaded in Prerequisite on page 28.

e Note:

The following procedure describes the sha256 file configuration. The same procedure can be used for
the md5 file.

b. Set Hash algorithm as SHA-256.
c. Configure the Checksum value.

i. Open the Recovery _Image-MX-ONE_x.x.spx.hfx.rcx.iso.sha256 file that you have already downloaded
in Prerequisite on page 28.

ii. Copy the hash value. For example,
7b3b3234b303ebe344bc0da8dc8663437612d0837a510a73629eb2123ec1b861.

iii. Paste the hash value in Checksum.
d. Click on Upload.
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5. After the iso file is uploaded, it will be displayed on the ISO images window.

Creating VM for MX-ONE on Proxmox VE
To create VM for MX-ONE on Proxmox VE:

1. Log in to the Proxmox VE.
2. On right top corner, click on Create VM.

The Create: Virtual Machine pop-up window is displayed.
3. Configure General:

a. Set Name as environment specific value. For example PROXMOX-LIM1.
b. Click on Next.
4. Configure OS:

Installing MX-ONE on Proxmox VE

a. Set ISO image as Recovery_Image-MX-ONE_xx.spx.hfx.rcx.iso from the drop-down menu.

b. Click on Next.
5. Verify the System configurations and click on Next.
6. Configure Disks:

a. On Disk panel, set Disk size (GiB) as environment specific value.
b. Click on Next.
7. Configure CPU:

a. Set Cores as environment specific value.
b. Click on Next.
8. Configure Memory:

a. Set Memory (MiB) as environment specific value.
b. Click on Next.
9. Verify the Network configurations and click on Next.
10. On Confirm page, verify the configuration and click on Finish.

After few minutes, the PROXMOX-LIM1 VM is successfully created and displayed on the home page.

Installing MX-ONE on Proxmox VE

To install MX-ONE on Proxmox VE:

1. On Proxmox VE homepage, navigate to Datacenter.
2. Select the VM created in Creating VM for MX-ONE on Proxmox VE on page 30.
3. Right click on the VM (For example, 100 (PROXMOX-LIM1)) and select Start.
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4. Click on Console.

The command prompt is displayed.
5. Execute the following command and press Enter key to start the installation.

i nstall

The installation takes around 10 minutes.

6. After successful installation, configure the MX-ONE as described in the Installing and Configuring MX-ONE
on page 32.



Installing and Configuring MX-ONE 11

With all the virtual MX-ONE servers in place and configured, it is time to build a PBX out of them. The procedure
of setting up the system is the same as for physical MX-ONE servers loaded with turnkey installations. The
difference lays in the access of the MX-ONE servers that is done through the respective client.

For more details see INSTALLING AND CONFIGURING MIVOICE MX-ONE.
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